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User Manual: 
 

1. Minimum Recommended settings 

 

2. Installation Procedure 

 

                     2.1 General-For Both AMIBROKER & METASTOCK          

Users. 

 

   2.2. Preparing Your AMIBROKER 

 

   2.3. Preparing Your METASTOCK 

 

3. Using Software 

 

      3.1. AMIBROKER 

 

             3.1.1. EOD Data 

 

             3.1.2. RT Data / IEOD Data 

 

         3.1.3. How to Backfill EOD/Historical Intraday data 

 
          
 

      3.2. METASTOCK 

 

          3.2.1. EOD Data 

 

              3.2.2. RT Data / IEOD Data 
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      3.3. Using Offline Mode 
             (Synchronize Database)- Get Eod & IEod Data. 

 

      3.4. Procedure to run exploration mode 

  

              3.4.1. Tick Mode 

 

              3.4.2. Fno Cash Exploration Mode 
 

              3.4.3. Curr Future Exploration Mode 

 

          3.4.4. All Exploration Modes 

 

          3.4.5. MCX Exploration Mode 

 

          3.4.6. NSE + MCX Exploration Mode 

 

    

4. Trading systems 
 

              4.1. Need AFL for AMIBROKER 

           

              4.2. Need Expert Systems For METASTOCK 

  

 5. Troubleshooting 

   

         5.1 How to start the Application 

 

         5.2 Getting fatal error on starting the application 

 

         5.3 Not getting any chart 

 

         5.4. Not Getting EOD/Corrupt EOD/Wrong EOD 
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         5.5. Not Getting RT Data 

 

         5.6. Registration/Expiry Issues 

 

             5.7. Upgrading from Demo to Paid user 

 

             5.8. Need Ticker List 

 

          5.9. Get Error AMIBROKER/METASTOCK Not    

                  Running 

          5.10. Need More Help 
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1. Minimum Recommended Settings 

 

     Supported Versions: 
     

� AMIBROKER: V 4.92+ 

� METASTOCK:METASTOCK  Professional 

V8+ 

� OS: Win XP SP2 

� DOT Net Framework-2.0 

               If you don’t have, Download .NET Framework 

     Directly from Microsoft website. 

� Then from our Software Installation Link, You 

can Download Data Provider 

� Internet Speed: Min 128kbps.Recommended-

256kbps+ 

                   

 

2. Installation Procedure 

       

Go to Control Panel/ Regional and Language    

Settings: 

      Choose Language shown is   : English (UK) 

      Date Time Format is: DD/MM/YYYY (Only in this 

      Format, don’t use –space etc.) 
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For AMIBROKER Users: 
 

   Please ensure that AMIBROKER is installed in %\Program  

Files \AMIBROKER  where  %  stands  for C: or  D:  or E:  

depending  upon  your current  partition from which you  

boot  your  operating System. 

 

No custom installation folder of AMIBROKER is supported 

 

2.1 Installation Procedure (step by step pictures-General 

for Both AMIBROKER & METASTOCK Users) 

   

  Step 1: Download application and Read through this manual step By 

step (Which you are anyway doing) 
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  Step 2: You will be taken to Page as below.     

 

 

 
       
 

 

Step 3: Click on Install. Warning: DO NOT USE FIREFOX OR 

OPERA OR CHROME. USE IE OR MAXTHON. 

 

Step 4:  It may give you a warning .Please accept and proceed to 

install 
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Step 5:  Let the application download and install itself 

 

 

 

 

 

Step  6:  Once  complete  Application  will  auto start  ,  you  can  

also  Go  to Start/All Programs/Market Data Provider/Data 

Provider and click it. 

 

 

 

 

 

 

 

 

 

 

 

Step  7:  If  You  Are  a  New  client  then,  you  will  get  a  

registration  form  as below. Please fill this form with required 

details. 
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1) Name- Your Full Name or any name by which you will like 

to   be addressed. 

2) Email ID-Please put your official email id or preferably 

yahoo   mail id. 

3) Choose your Software, either Amibroker or Metastock. 
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Once  you  shall  click  auto  register, it  will  give  you a success  

message  and message to restart Data Provider 

 

 

  Login  115  Error -  If  you  get  this  error,  you  have  a  

firewall  which  is .  Please  ensure,  you  have  Norton  Ghost,  

Zone  alarm  off  and  your language settings are as per following: 

   

 

 

 

 

 

. 

 

 : 
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Following  pop-up  will  appear  if  you  were  properly  

authenticated  and  above  was successful. 
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2.2 Preparing Your AMIBROKER 
      Step 1: 

     1) Create A New Database As Above. Go To AMIBROKER. 

      Menu:   File->New Database 

      Choose Path As:  %\Program Files\ AMIBROKER \ RT. 

     Click Create 
 Only after creating the Database, Bottom options will be 

visible. 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

2) Choose Database Settings As Following. 

Data Source: DATA PRO 44xxx (PRESENTLY DATA PRO 

44320) 

No of Bars- 250000 

Base Time Interval- TICK (RECOMMENDED) 
Demo users of AMIBROKER can’t select this option.  Please then use 

instead of Tick. 

3) Click Okay 
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Step 2: Add SYMBOL in AMIBROKER using Menu: - SYMBOL-

New –ACC. After doing that following should be displayed.  The 

Name of the symbol in the Main Window- AMIBROKER- 

[NIFTY……Daily] 
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IMP: If it does not show like above then Click 

AMIBROKER/VIEW/ Charts. Basic Indicators/ Price (all in one).   

A pane will be added and Step 2 displayed.  If still  you  can’ see  

in  AMIBROKER  main  window-  Top  Left  Then  Please check 

AMIBROKER version is greater than 4.92 

 

 

 

Step 3: 

 In AMIBROKER, Please see Bottom Right: It will Show that Data 

 Provider is logged and Green Button is seen. Please refer the     

picture below: 

 

 

 

Step 4: 
 

Your AMIBROKER is ready to use. Please go to Usage Guidelines 

In section 3.1 to see how to get data. 
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2.3 Preparing Your METASTOCK: 

 
Step 1: 

        Please Ensure that METASTOCK database is downloaded 

from link: 

Metastock Download and unzip same to C:\ 

 After finishing you should have folders like C: \Equis\EOD\   and 

C: \Equis\RT 
 

PLEASE  DO  NOT  UNZIP  TO  ANOTHER  EQUIS. 

Example :  FOLDER  WHICH  SHALL  MAKE UR DATBASE 

AS C:/EQUIS/EQUIS is incorrect 
 

 

Step2: 

          Please Open Your MetaStock & Set Number of Bars 

          Path:-File->Open->Options->Load Options 

          No. of Bars-65000. 
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Step3: 

Please Open Your METASTOCK and load any symbol file from 

any of the folders. You  should  see  the  name  of  the  symbol  as  

shown  below  on  picture’s  title: 

METASTOCK PROFESSIONAL-[Boeing Co] or METASTOCK  

PROFESSIONAL-Boeing Co 

FOR EXAMPLE: (SEE PICTURE BELOW) 
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Wrong way to display the chart for a selected symbol (using 

templates): 

 

 

 

 

 

You have directly applied template.  Please close this and open it 

directly from database folders and then apply indicators. 

 

Step 4: 

Your METASTOCK is ready to use. Please refer to Usage 

guidelines in section 3.2 for getting data. 
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3. Using Software 

 
3.1. Using Data Provider for AMIBROKER 

 IMP  Note for Non Exploration Package: 

1) The DP SEES what u SEE.  So if you are seeing Nifty Chart, 

DP will get u data for NIFTY.  As  soon  as  you  open  

another  chart  the  Data  for  that  Chart  will  be  brought.  

You  can  have  20  charts  open-  BUT  WHAT  YOU  HAVE  

PRESENTLY   SELECTED  and  in  VIEW-  you  shall  get  

data for that  chart. This is an intelligent system designed for 

benefit of users, to view the data with just one press of button 

there is no need of separate backfill or any preparation, DP 

handles everything and follows you with whatever chart you 

are viewing auto backfilling when you switch charts instantly. 

(Note: this  restriction  is not there for Exploration packages) 

  3.1.1 EOD for AMIBROKER:  ONLINE MODE: Gets Chart 

instantly from 1994 

 

• Open AMIBROKER. Choose your symbol from Drop down 

box. 

• Make sure the name is displayed in title bar. 

See Picture above 

• Click Start/Market Data Provider/Data Provider. 

• Once the application opens. 

• Click on Top Left to change modes between 
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RT Mode 

EOD Mode 

EOD + RT Mode (Only For Amibroker) 

                See Picture Below  

 
 

 
 

 
 

When we run DP initially we see   RT Mode 

Click on RT Mode  to change to  EOD + RT 

Click on EOD + RT  to change to  EOD Mode 

 

On Clicking Get Me Data in the above modes your Get Me Data 

button will show 

Get- AMI-RT or Get-AMI-Eod +RT or Get- AMI-Eod 
 
 

 

 

 

 

 

3.1.2 RT for AMIBROKER: 
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Open AMIBROKER  

Make sure the name is displayed in title bar.  

See Picture: 

 
 

Click Start/Market Data Provider/Data Provider. 

Once the application opens, Click Top LEFT UNTILL You See 

EOD+RT 

Click -> Get Me Data. 

Your Get Me Data button will show-> Get -> Ami - EOD+RT 
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3.1.3 How to Backfill EOD/Historical Intraday data 
Click Backfill menu- Go on Backfill EOD / Intraday Data of Selected 

Stocks. 
 

 

 
 

 

 
           

    Select symbols from Dropdown list Box & using Add to List button add 

symbols to ListBox. Repeat same process to add more symbols. Then select 

all symbols & do right click on selected symbols. It display different options 

to Backfill your stocks as follows. 

 

 

1.  Update EOD of Selected Stocks. 

2. Backfill Previous days +Current Day’s Intraday Data. 

3.  Backfill Only Current day’s data. 

4.  Delete EOD data. 

5. Delete intraday data. 
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It shall start downloading data.  Please be patient till the downloading is 

finished. 

You shall get a confirmation message when downloading is finished. 
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3.2. Using Data Provider For METASTOCK: 
IMP: 
 

You CANNOT open more  than  one  chart  of same  symbol  i.e. if  you  

have opened ACC  chart  form  eod  folder  then  same  time  you  can  not  

open  ACC  chart  from  RT folder. 
 

2) The software SEES what you SEE.  So  if  you  are  seeing  Nifty  

Chart,  the software  will  get  u  data  for  NIFTY.  As soon as  you  

open  another chart  the Data  for  that  Chart  will  be  brought.  You 

can have 20 charts open- BUT WHAT YOU HAVE PRESENTLY 

SELECTED and in View- you shall get data for that chart. This is an 

intelligent system designed for benefit of users, to view the 

data with just one press of button there is no need of separate 

backfill or any preparation, DP handles everything and 

follows you with whatever chart you are viewing auto 

backfilling when you switch charts instantly. 

(Note: this  restriction  is not there for Exploration packages) 
 

1) If Click Start/Market Data Provider/Data Provider  

Once the application starts 

      You can change the mode by clicking on TOP left button. 

       RT Mode 

 
     EOD Mode  
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    Click Get Me Data 

    To get RT data open a Chart from RT folder, On pressing “Get Me Data” 

DP button will show Get ->Meta-RT. 

      
 

To get EOD data open a Chart from EOD folder. On pressing “Get Me 

Data” DP button will show Get->Meta-EOD. 

 

 
 

 

 

 

 

3.2.1 EOD for METASTOCK:  ONLINE MODE:  Gets instant 

         Chart from 1994 
 

 
 

Open METASTOCK. Choose your symbol from C:\Equis\EOD 

Make sure the name is displayed in title bar: SEE PICTURE Above: 

      Do not open EOD and RT charts of same symbol in Metastock at the 

       Same time when running Data Provider. 
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     3.2.2 RT for METASTOCK: 

     
       Open METASTOCK. Choose your Symbol from C: \Equis\RT\ 

        Make sure the name is displayed in title bar. 

        See Picture 

 
 

3.3 Using Offline Mode – Get EOD & IEOD Data 

Synchronize Database  
 

Click Backfill menu- Go on New Feature: Synchronize complete 

Database-Eod/IEOD Data 
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       Choose Synchronization option from Dropdown List Box. 

It displays different options as follows: 
1) Import All Eod Cash & Fno from 1994-Required one time import. 

        A) Download Complete Database from Link: 

             Download Ready to Use Eod Database. 

        B) Please unzip the file and store unzipped folder any where 

              On your computer.                 

        C) Select in Drop down Options:” Import All Eod Cash & Fno from      

             1994-Required one time import” and then click on start button. 

             It shall start importing Data & after that DP shall automatically  

             Restart. 

2) Update Eod Data Till Today- if less than 30 days of import. 

   A) Before using this option, you must first import All Eod cash & fno data    

         As per above option.          

   B) Select this Option to update eod database (From Last updated Date to   

         Current Date).       

3) Update Cash IEOD data Till Today.  

          To update cash IEOD data from Last Updated date to Current date. 

Please select this option and click Start. 

 

4) Update Future IEOD data Till Today. 

          To update future IEOD data from Last Updated date to Current date. 

Please select this option and click Start. 

5) Update MCX EOD Till Today. 

          To update MCX EOD data from Last Updated date to Current date. 

Please select this option and click Start. 

 

6) Update MCX IEOD Till Today. 

         To update MCX IEOD data from Last Updated date to Current date. 

Please select this option and click Start. 
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3.4 Procedure to run Exploration mode 
 

3.4.1 Tick Mode 

           Choose this mode to get automatic Backfill of EOD / RT / Intraday 

data for currently viewed stock in Amibroker or Metastock. 

 

 
 

NOTE: For all below exploration modes, to backfill your list 

you do not need to Stop DP, leave it running with Get Me Data. 

Simultaneously backfill your desired list for Previous+ Current 

Day from Backfill Window. 

 

3.4.2 Fno Cash Exploration Mode 

 

 
 

         Choose this mode to get current streaming data of all FNO Cash Stocks. 

If you want to Backfill EOD/Historical   Intraday data of any stock, you can 

do so even while running in exploration mode by going to Backfill menu on 

DP. Please refer to section 3.1.4. 

 

 

 

3.4.3 Curr Future Exploration Mode 
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         Choose this mode to get current streaming data of all Current Future . If 

you want to Backfill EOD/Historical   Intraday data of any stock, you can do 

so even while running in exploration mode by going to Backfill menu on DP. 

Please refer to section 3.1.4. 

 

3.4.4 All Exploration Modes 

 

 
 
         Choose this mode to get current streaming data of all NSE stocks + 

Future Stocks at a time. If you want to Backfill EOD/Historical   Intraday 

data of any stock, you can do so even while running in exploration mode by 

going to Backfill menu on DP. Please refer to section 3.1.4. 

 

 

 

 

 

 

3.4.5 MCX Exploration Mode 
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Choose this mode to get current streaming data of all MCX counters at the 

same time. If you want to Backfill MCX counters at the same time of any 

stock, you can do so even while running in exploration mode by going to 

Backfill menu on DP. Please refer to section 3.1.4 

 

 

 

3.4.6 NSE + MCX Exploration Mode 

 

 
 

 

 

         Choose this mode to get current streaming data of all SP 500 cash 

stocks + current month futures + all MCX counter at the same time. If you 

want to Backfill EOD/Historical   Intraday data of any stock, you can do so 

even while running in exploration mode by going to Backfill menu on DP. 

Please refer to section 3.1.4. 
 

 

 

 

 

4. Trading systems 
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       4.1Need AFL for AMIBROKER 
         We provide AFL for all kinds of indicators.  Please send us email    

        With your formulae and we shall send you the indicator. Please Visit the     

        Link for indicators. 

  

       4.2 Need Expert Systems For METASTOCK 

         We provide AFL for all kinds of indicators.  Please send us email   

          With your formulae and we shall send you the indicator. Please Visit  

          The link for indicators. 
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 5. TROUBLESHOOTING 

 

      5.1. Can’t find how to start the Application 

      Ans. Follow the diagram sequentially 

   

        

 

     5.2. I get fatal error on starting the application: 

 
Ans. Check for your language and Date/Time settings in control panel. 
 
     

 

       

 

 

 

 

 

5.3 Can't get any chart, everything is blank 
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 Ans. Check following step wise: 

a) Is DP running? 

      Have u clicked “Get Me Data “Button to show as following: 

 
 

b)   Have you selected the symbol 

 
 

  c)  Have u checked your database settings 
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 5.4 Can’t Get EOD Data or EOD Data is coming wrong or not 

getting updated EOD data 
 

Ans: 

1) Choose HELP/Update My rights. 

2) Choose Options/ Rebuild My database. 

3) Please ensure settings as per Sec 3. are done properly. 

4) Please check that symbol format is correct. 

 
 

5.5. Can’t Get RT Data or not getting updated RT data 
Ans: 

1)  Choose HELP/Update My rights 

2) Choose Options/ Rebuild My database. 

3) Choose options /Maintenance /clean RT data. 

  4)  Please ensure settings as per Sec 3. are done properly 
 

5.6. Can’t Get Registered. 
Ans: 

    1) Choose HELP/Update My rights. 

    2) Please ensure that you are not behind a corporate firewall. 

    3) If you get Error 230,231, 232 then Internet is down / very slow or 

  your Demo has expired. 

   

5.7. Upgrading from Demo/paid users. 
Ans: 
 

      Choose HELP/Update My rights. If your email ID used for 

   Registration and payment are same, the server shall immediately give 

   You your rights else please leave an email with your Pay pal receipt 

   Number and your registration id. If you do not remember same, give 

   Approx date of registration and support personnel shall clear your 

 Entry. 
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5.8. Need Symbol List. 
  

Ans: 

  Please note that it is available as download on the download page. 

  Click on Symbols to get the List. 

 

5.9. Error Message that AMIBROKER/ METASTOCK is not 

running although it is running. Is your software blind???? 

Ans: 
    

 Yes Sir/Madam. It knows only one thing- AMIBROKER and the 

Symbol. Please see that following should be visible in AMIBROKER 

Window-  The  Name  of  the  symbol  in  the  Main  Window-  

AMIBROKER-[ACC……Daily] 

 

AmiBroker: 

 

 
 

OR 
 

This will change depending on Tick, Minute, etc views 

Note the symbol name shown in Title Bar. 
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MetaStock: 

 

 

 

 

OR 
 

   

 

 

  

 

 

5.10. How do I open my demo account? 

 Ans: 

 Register for new account & you will get 5 days demo version. 
 

5.11 Need more help? 

Ans: 

 Send an Email at care@Market-Data-Provider.com 
 

 

 

 

 

Have A Nice Trading Day Ahead!!! 


